Vergleich der Mafinahmen ,, Aufforstung” und ,Wiedervernassung” fiir das Entwicklungsziel
»Verringerung der Stoffeintrage an Stickstoff”

Beispielaufgabe 2

Elbe DSS
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Vorbemerkung;:

Zum derzeitigen Entwicklungsstand des Elbe-DSS liegt ein Software-Prototyp vor, der bereits die wesentlichen Merkmale der spate-
ren Pilot-Version enthalt. Allerdings sind noch nicht alle Funktionalitdten implementiert, was sich in Teilen durch noch nicht imple-
mentierte Dialoge und Meniis oder auch durch Vorabversionen von Ausgabefenstern bemerkbar macht.

Ziel des vorliegenden Prototypen ist es daher, vor allem einen Eindruck der Arbeitsweise und des Look-and-Feel des Elbe-DSS zu
vermitteln. Einen Anspruch auf Vollstandigkeit, Fehlerfreiheit oder Korrektheit aller Ergebnisse kann die vorliegende prototypische
Version jedoch nicht erfiillen.

Um die Funktionsweise und die Arbeit mit dem Elbe-DSS zu demonstrieren wurden zwei Beispielaufgaben formuliert, die von den
Teilnehmern des Nutzertreffens exemplarisch bearbeitet werden sollen.

Aufgabenstellung:

Zur Verringerung der Stickstoffeintrage und der Stickstoffkonzentrationen in den FliefSgewdssern sollen mit Hilfe des Elbe-DSS die
potentiellen Mafinahmen Aufforstung und Wiedervernassung hinsichtlich ihrer Wirksamkeit verglichen werden.

Durchfiihrung;:

Die Aufgabe gliedert sich in zwei Teile: Im ersten Teil werden die Mafinahmen Aufforstung und Wiedervernassung sowie deren
Auswirkungen mit dem DSS ermittelt. Im (optionalen) zweiten Teil werden die gewonnenen Ergebnisse mit Hilfe eines Vergleich-
werkzeuges kartografisch verglichen.



Vorgehen:

Aufruf des Elbe-DSS

Nachdem Sie das Pilot-DSS-Programm installiert haben (siehe Installati- e =
onsanleitung) konnen Sie das Elbe-DSS tiber das Startmenii -> Programme o dreem
-> Elbe-DSS -> Elbe-DSS starten. In dem Offnungsfenster (Abbildung 1) e
wihlen Sie ElbeDSS.eif und dann "Open". a8
Hinweis: Sollte ElbeDSS.eif nicht angezeigt werden, so wechseln Sie in den Ord- =
ner c:\Programme\ Elbe DSS\data und wihlen Sie dann ElbeDSS.eifl aus-! .
Die EIF Détei enthdlt die Standardeinstellungen des Elbe-DSS. Vorge- 5 e S e
nommene Anderungen konnen spater unter anderem Namen im selben T owws  [era S e |
Format gespeichert werden. Abbildung 1. Auswahl der Datei ElbeDSS.eif nach Aufruf
des Elbe-DSS.

Im nun erscheinenden Fenster (Abbildung 2) erscheint eine Liste von Mo- i X
dellen, die im Elbe-DSS integriert sind. Standardmafiig sind alle Modelle Modelblock | Enatled |
aktiviert. Sie sollten fiir diese Beispielaufgabe nur den Modellblock ,Mo- :bhtt o ::
neris” aktivieren, um dadurch die Berechnungszeiten deutlich zu verkiir- GREAT-R r
zen. Die restlichen Modelle werden fiir diese Beispielaufgabe nicht beno- P Pl ;
tigt. Diese Auswahl kann mit OK bestdtigt werden. Mover B

Mavigation

Abbildung 2. Dialogfenster Auswahl Modelle.

1 Dies setzt vorraus, dass sie das Elbe-DSS im Standardverzeichnis installiert haben. Falls Sie das Elbe-DSS in einem anderen Verzeichnis installiert haben, befin-
det sich die ElbeDSS.eif Datei im bei der Installation angegebenem Verzeichnis im Unterordner data..



Nachdem sie OK angeklickt haben erscheint nach kurzer Verzogerung das
Systemdiagramm fiir das Elbe-DSS (Abbildung 3). Wenn Sie mit der Maus
tiber die vier Teilmodule fahren, werden diese jeweils schwarz hinterlegt.
Sie konnen nun das Modul Einzugsgebiet auswéhlen, indem Sie das Mo-
dul anklicken.

Ready [

Abbildung 3. Systemdiagramm und Auswahl des Moduls
Einzugsgebiet.

Es erscheint das detaillierte Systemdiagramm fiir das Einzugsgebiet
(Abbildung 4). Dieses neue Fenster enthdlt fiir das Modul Einzugsgebiet
die im Elbe-DSS abgebildeten Systemelemente, wie zum Beispiel die Ge-
bietseigenschaften Niederschlag, Topographie, Landnutzung, usw. oder
die Abflusskomponenten Oberflachenabfluss, Infiltration usw. Falls Sie
eines der Systemelemente anklicken (z.B. Landnutzung) erhalten Sie be-
reits in dieser Version zusétzliche Informationen in Form von Karten o.a. —
in der Endversion werden hier zu allen Elementen Informationen vorlie-
gen.

Ready [ 4

Abbildung 4. Detailliertes Systemdiagramm des Moduls
Einzugsgebiet.



Beachten Sie bitte auch (oben) die Reiter des Fensters:

— System

— Ext. Szenarien

— Mafinahmen

- Entwicklungsziele

Uber diese Reitern gelangen Sie zu den Systemelementen, die Zugang zu den wesentli-
chen Eingabe- und Ausgabedialoge fiir die Arbeit mit dem Elbe-DSS bieten. Die normale
Vorgehensweise bei der Arbeit mit dem Elbe-DSS besteht darin, zunachst ein Entwick-
lungsziel auszuwdhlen. Gehen wir in unserem Beispiel zunachst davon aus, dass Sie das
Entwicklungsziel , Verringerung von Schadstoffeintragen” verfolgen wollen. Offnen Sie
hierzu den Reiter Entwicklungsziele (Abbildung 5) und klicken Sie auf den Kasten ,, Ver-
ringerung von Schadstoffeintragen”.

Es erscheint ein Ergebnisdialog, der den derzeitigen Status fiir dieses Entwicklungsziel
darstellt (Abbildung 6).

Uber das Listenfeld , Substanz” wihlen Sie hier ,Gesamtstickstoff“ aus. Mit der Aus-
wahl aktualisiert sich sofort der Fensterinhalt. Wie der Darstellung zu entnehmen ist,
belduft sich die Stickstofffracht fiir das deutsche Gesamteinzugsgebiet auf ca. 222.600
t/a, von denen der grofste Teil iiber das Grundwasser eingetragen wird, gefolgt von dem
Eintrag tiber Dranageflachen, Punktquellen und urbane Flachen.

Hinweis: Der Dialog ist zundchst nicht initialisiert. Die Anzeige wird erst berechnet, wenn Sie
in der Substanzliste eine Anderung vornehmen.

EINZUGSGEBIET

Abbildung 5. Auswahl des Entwicklungszie-
les , Verringerung von Stoffeintrigen” im
Modul Einzugsgebiet.

Abbildung 6. Darstellung des Status-Quo fiir
das Entwicklungsziel , Verringerung von
Stickstoffeintragen”.



1. Teil: Durchfiihrung der Mafsnahmen

Nun mochten Sie zundchst die Auswirkungen einer

M Einzugsgebiet

Aufforstungsmafinahme fiir das Entwicklungsziel ,,Ver- System | Ext. Szenarien MaBnshmen | Enticklungszile |
ringerung von Schadstoffeintragen” untersuchen: gehen Bieoiog gestenenss] EINZUGSGEBIET
Sie im feinen Systemdiagramm fiir das Einzugsgebiet i T r
(Abbildung 4) auf den Reiter ,Mafinahmen” und wah- _ <.£'~.uﬁ|:|r':5:turu;]
len Sie die Mafinahme , Aufforstung” durch Klicken aus gjrn Eiﬁf’“”g [iehbesatz)
(Abbildung 7). Daraufhin folgt ein Eingabedialog zur Randstrefer Candwirtschat-
Definition einer Aufforstungsmafinahme (Abbildung 8). pzj::$:|e e e

powasser [y

P9 1 [Punkt- | [Difuse

quellen| |Guellen

Abbildung 7. Mainahmen im Modul Einzugsgebiet und Auswahl der Mafs-
nahme ,Aufforstung”.



Aufforstungsmafsnahmen konnen im Elbe-DSS definiert werden, durch Angabe
des prozentualen Anteils an Acker- und Griinlandflachen, die in Waldflache

&1 Aufforstung

umgewandelt werden. Zusatzlich kann unterschieden werden zwischen RilEeE e
{+ Gesamteinzugsgebiet

1. einer Reduktion der landwirtschaftlichen Intensitit — mit der Reduzie- Y e
rung der landwirtschaftlichen Nutzflaichen sinken die Ernte- und die (" Teilgehiet
ausgebrachten Stickstoffmengen Gebistsauswahl

2. keiner Reduktion der landwirtschaftlichen Intensitat — mit der Reduzie- =
rung der landwirtschaftlichen Nutzflaiche kommt es zu einer Konzentrie- Karte...
rung auf den verbleibenden Flachen und somit nicht zu sinkenden Ernte- Aufforstung Variante
und ausgebrachten Stickstoffmengen. {+ Redukkion der landwirtschaftlichen Intensitat

Zur Bestimmung der hier zu betrachtenden Aufforstungsmafinahme legen Sie Kein Redukkion der landuirtschaftlichen Intensi:at

zundchst den Raumbezug fest: soll die Mafinahme fiir das ganze Einzugsgebiet, 2 el e s A ke

ein Teileinzugsgebiet oder einen Koordinierungsraum gelten? Wahlen Sie in Flache [km?] 70903

unserem Beispiel ,Gesamteinzugsgebiet”. Als Aufforstungsvariante wahlen Sie Unwandiung in Waldflache [%]

,Reduktion der landwirtschaftlichen Intensitat”. SchliefSlich wahlen Sie den An- 0% 10%

teil der landwirtschaftlichen Nutzflache, die aufgeforstet werden soll mit Hilfe —

der beiden Schieberegler. Setzen Sie beide auf den maximalen Wert von 10% Reduzierung des Grinlandanteils

fost. Flache [km?] 9985.6
Urmwandlung in Waldflache [96]

Die Einstellungen werden sofort {ibernommen, miissen also nicht durch OK 0% 10 %

bestitigt werden. Schlieen Sie den Dialog wieder. —_—

Zurlicksetzen

Abbildung 8. Eingabedialog fiir die MaSinahme Auf-
forstung.




Damit die Auswirkungen der Mafinahme berechnet werden konnen, muss ein ES Elbe - ElbeDSS
Simulationslauf durchgefiihrt werden. Das Starten des Modellaufs geschieht Datei Bearbeiten Ansicht RSN Ferster
tiber den Meniipunkt Simulation -> Starten (Abbildung 9). O = = Start Cbrl+FS |

Hinweis: Ist der Meniipunkt Start ausgegraut, liegt dies daran, dass die Simulation Abbildung 9. Das Starten einer Simulation geschieht
bereits vorgenommen wurde und keine Anderungen erfolgt sind, die eine erneute Si-  iiber den Meniipunkt ,Start” im Menii ,Simulation.
mulation erfordern. In diesem Fall sollten die Ergebnisse vorhanden und die nachfol-

genden Arbeitsschritte ohne nochmalige Simulation zu erledigen sein.

Hinweis: Wurde beim Starten des Elbe-DSS der Modellblock , GREAT-ER” aktiviert

[l Stoffeintrige

(Abbildung 2), so dffnet sich nach dem Abfahren des Simulationslaufes ein Komman- —
. . . + Gesamteinzugsgebiet
dozeilenfenster, in dem der Fortschritt der Berechnungen von GREAT-ER dargestellt  Telgebie
. . . . . . . . . . . Teileinzugsgebiete Substanz

wird. Bitte unterbrechen Sie die Simulation nicht, da dies das Elbe-DSS in einen nicht siill
definierten Zustand versetzen konnte. Die Simulation sollte je nach eingesetztem e ——

. . Atmospharischen Direkteintrag [tfa]:| 6476.54 Oberflachenabfluss [Hal:|  2155.07
ReCthET' 2 - 4 Ml?’luten bei’lOtlgen. Drénage Flachen [tfa]: 48476.04  punktquellen [tja]: ’m

. . . . Grundwasser [tfa]: lm Urbane Flachen [tfa]: lm
Nun kann das Ergebnis der Mafinahme , Aufforstung” im Ergebnisdialog Erosen [l BRI osamtsurme[tfals 2177505
,Stoffeintrage” abgelesen werden (Abbildung 10). Die Berechnungsergebnisse - — T
2,98 % Atmosphérizchen Direkteintrag

W 0,99 % Oberfldchenabfluss
W 2,23 % Erozion

W 42 51 % Grundwasser

O 763 % Urbane Fldchen

W 21,26 % Punktquellen

B 225 % Dranage Flachen

wurden, unter Berticksichtigung der definierten Mafsnahme, durch die Simu-
lation aktualisiert. Im Vergleich zu der Ausgangssituation ohne Mafsnahme
reduziert sich die gesamt eingetragene Stickstoffmenge fiir das deutsche Ge-
samteinzugsgebiet von ca. 222.600 t/a auf ca. 217.400 t/a. Weiterhin stellt der
Eintrag iiber das Grundwasser den anteilig grofsten Eintragspfad da.

Neben der aggregierten Darstellung der berechneten Stickstoffeintragsmen- ate
gen kann auch deren Verteilung im Elbe Einzugsgebiet betrachtet werden.

Driicken Sie hierzu den Knopf ,Karte” im Dialog ,Stoffeintrage” (Abbildung  Apbildung 10. Darstellung der Auswirkungen der Mag-

10). nahme ,Aufforstung” fiir das Entwicklungsziel , Ver-
ringerung von Stickstoffeintragen”.



Als Ergebnis erhalten Sie eine georeferenzierte Dar-

stellung der Stickstoffemissionen auf Teileinzugsge-
bietsebene (Abbildung 11).

Die Legende befindet sich im linken oberen Teilfens-
ter, darunter befindet sich das Ubersichtsfenster. Auf
der rechten Seite befindet sich oben die Liste der im
Viewer enthaltenden thematischen Ebenen, wahrend
sich darunter verschiedene zu Gruppen zusammen-
gefasste Werkzeuge befinden.

Uber die Auswahl der Schaltfliche ,Zoom Operati-
ons” im rechten Teil des Fensters kann der Aus-
schnitt verandert werden (Abbildung 12). Benutzen
Sie hierzu den Button =, um einen beliebigen Aus-
schnitt zu vergrofiern. Mit den Buttons , &l kén-
nen Sie in die Karte hinein- oder herauszoomen, der
Button ! stellt den gesamten Kartenbereich dar und

der Button ‘M erlaubt das Verschieben der Karte.

EEESE000000COEE

Abbildung 11. Kartendarstellung des Ergebnisses der Mafsnahme ,,Aufforstung”
fiir das Entwicklungsziel , Verringerung von Stickstoffeintragen”.
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Abbildung 12. Der ,,Zoom Operations“-Reiter dient der Navigation auf der Karte.
Der ,,Grid operations”“-Reiter dient unter anderem zum Speichern von Ergebnis-
darstellungen im Rasterformat.



Zur spéteren Analyse und einem Vergleich mit der Mafinahme ,, Wieder-

verndssung” speichern Sie die dargestellte Ergebniskarte. Hierzu dient der ERE @ bciriclaioax? - eBmsE
|

Meniipunkt ,,Save Grid” im Menii ,,Grid Operations” (Abbildung 12). ¢

Zuletzt
verwendete 0.

Desktop

Wahlen Sie eine geeignete Bezeichnung und einen geeigneten Speicherort
aus, damit Sie das Berechnungsergebnis zu einem spateren Zeitpunkt wie-
der finden (Abbildung 13).

Hinweis: Ist das Menii ,,Grid operations” nicht aufgeklappt so kann es durch Kli- Eigene Dateien
cken auf den Meniibalken sichtbar gemacht werden. o8
Lassen Sie die Kartendarstellung (Abbildung 11) und den Ergebnisdialog A'bEi_tsplatz | =

. . o . . . . ‘_- [ ateiname: n_aufforstung_10_10) - Speichern
,',.?ftofiemtrage (Abbildung 10) fiir die nun folgenden Betrachtungen ge Neuwerémm o e = |—|Abh[echen
offnet. ung trechen |

Abbildung 13. Speichern der Ergebniswerte der Auffors-
tungsmafinahme

Um eine Uberlagerung verschiedener Mafinahmen zu vermeiden, setzen Sie zunichst die Aufforstungsmafinahme in ihren ur-
spriinglichen Zustand zuriick. Offnen Sie dazu erneut den Eingabedialog , Aufforstung” (Abbildung 8) durch Klicken auf das Sys-
temelement , Aufforstung” im Reiter ,MafSnahmen” (Abbildung 7) und aktivieren Sie den Knopf , Zuriicksetzen”. Die gewahlten
Schiebereglereinstellungen werden daraufhin jeweils auf 0% zuriickgesetzt. Ubernehmen Sie die Einstellungen, indem Sie den Ein-
gabedialog ,, Aufforstung” wieder verlassen und starten Sie erneut die Simulation (Abbildung 9).



Der Ergebnisdialog , Stoffeintrage” und die Karten-
darstellung werden daraufhin automatisch aktuali-
siert. In der Kartendarstellung wird somit die Vertei-
lung der aktuellen Stickstoffeintragsmengen fiir das
Elbe Einzugsgebiet ohne Annahme einer Mafsnahme
dargestellt (Abbildung 14)

Zur spateren Analyse speichern Sie auch diesen Refe-
renzzustand mit Hilfe des Mentipunktes ,Save Grid”
im Ment ,Grid operations” (Abbildung 12). Wahlen
Sie eine geeignete Bezeichnung und einen geeigneten
Speicherort aus, damit Sie den Referenzzustand zu
einem spateren Zeitpunkt wieder finden (Abbildung
15).

B Gesamtstickstoff[t/a] (1 :1.67433e+006 )

T EC

[ 420... 4520
[ 2900... 5200

(—Trr—
&l & wle]
popy | 3

Abbildung 14. Darstellung des Status-Quo fiir das Entwicklungsziel ,, Verringe-
rung von Stoffeintragen” im Elbe Einzugsgebiet.

Speichern unter

D

Zuletzt
wenwendete D,

=
L
Desktop

Eigene Dateien

Arbeitzplatz

ung

Speichern in: |@be\sp\e\aufgahe2 j & rj{ Ea-
[Drateiname: |n_rEfErenj j Speichern
Metzwerkumgeh  Dateityp: [ s Filess | Abbrechen

Abbildung 15.Speichern des Referenzzustandes.
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Nun mochten Sie noch die Auswirkungen einer M Einzugsgebiet

Wiedervernassungsmafinahme fiir das Entwick- System | Ext Szenarien Mainshmen | Entwickhingszile |
. . PSR EINZUGSGEBIET
lungsziel , Verringerung von Stoffeintragen” un Bholog gesteuenes|
tersuchen, um schliefllich die beiden Mafinahmen Abflussmanagement| {Entsiegelung]
miteinander vergleichen zu koénnen. Gehen Sie |Landnutzunﬂ%uﬁmwng|
hierzu erneut in den Reiter , Mafinahmen” im Renaturisrung
. . et . . der Auen [/iehbesatzp
Einzugsgebietsmodul und wahlen Sie die Mafs- ST
X 5 . . anasirenen-
nahme ,, Landwirtschaftliche Praxis” durch Ankli- programme
cken aus(Abbildung 16). Karnmunale
Abwasser— —y 4 v 4
renigung Punkt- | |Diffuse

quellen| [Cuellen

Abbildung 16. Mafinahmen im Modul Einzugsgebiet und Auswahl der Mafinahme
,Landwirtschaftliche Praxis”.

Hinter der MafSnahme , Landwirtschaftliche Pra- & MaBnahmen: Landwirtschaftl... [= | 5 |[X]

xis” verbirgt sich ein ganzes Mafsnahmenbiindel: EINZUGSGEBIET

Anderung der Erhéhung d. Boden-
Dingebestirmmungen]  |bedeckungsgrades

es erscheint ein weiteres Fenster mit diesen Ein-
zelmafinahmen (Abbildung 17). Wahlen Sie

. . . Anderung der Urnstellung auf dko-
,,Wledel‘Verl’laSSUI’lg" durch Klicken aus. Gilleaushbringung|  Jlogischen Landbau

Erosionsschutz

Abbildung 17. Einzelmainahmen des MafSinahmenbiindels ,,Landwirtschaftliche Pra-
xis” und Auswahl der Mafinahme ,,Wiedervernassung”.
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Darauthin folgt ein Eingabedialog zur Definition einer Wieder-
verndssungsmafsnahme (Abbildung 18).

3 Wiedervernassung

. . . . Wirkungsbereich
Durch eine kiinstliche Entwasserung von Feuchtgebieten wird

. . . ; . {* (Gesamteinzugsgebict
eine landwirtschaftliche Nutzung dieser Standorte ermoglicht.

Unter Wiederverndssung wird im Elbe-DSS der Riickbau von G:bi;zfj::.:hl
Entwaisserungssystemen verstanden, um urspriingliche Feucht-
flachen zuriick zu gewinnen. -
Wiedervernassungsmafinahmen konnen im Elbe-DSS durch TR S
prozentuale Angabe des Dranageflichenanteils, der wiederver- (" Feuchtflachen werden weiter landwirtschaftlich genutzt
ndsst werden soll definiert werden. Dabei kann unterschieden O Bl B e e e s TR e Pt oy oeen
werden, ob die so entstehenden Feuchtflachen einer weiteren
landwirtschaftlichen Nutzung unterzogen oder einer natiirlichen Reduzierung des Dranageflachenanteils [%]
0% 30 %

Vegetation tibergeben werden. Eine extensive Bewirtschaftung
von Feuchtflichen und der damit verbundene Riickgang der
landwirtschaftlichen Intensitat kann im Elbe-DSS allerdings nur

unzureichend abgebildet werden. Es empfiehlt sich daher Wie- M
derverndssungsmafinahmen zu betrachten, bei der Feuchtfla-
chen einer natiirlichen Vegetation tibergeben werden.

Abbildung 18. Eingabedialog fiir die Mafnahme Wiedervernissung.

Zur Bestimmung der hier zu betrachtenden Wiedervernassungsmafinahme legen Sie zundchst den Raumbezug fest: soll die Mafs-
nahme fiir das ganze Einzugsgebiet oder ein Teileinzugsgebiet gelten? Wahlen Sie in unserem Beispiel ,, Gesamteinzugsgebiet”. Als
Wiedervernassungsvariante wahlen Sie , Feuchtflichen werden einer natiirlichen Vegetation tibergeben”. Schlieilich wahlen Sie
den Dranageflachenanteil, der wiederverndsst werden soll mit Hilfe des Schiebereglers. Wahlen Sie einen Wert von 20%. Die Ein-
stellungen werden sofort tibernommen, miissen also nicht durch OK bestatigt werden. Schlieflen Sie den Dialog wieder.

Damit die Auswirkungen der MafSsnahme berechnet werden konnen, muss ein erneuter Simulationslauf durchgefiihrt werden. Das
Starten des Modellaufs geschieht wie bei der Aufforstungsmafinahme tiber den Mentipunkt Simulation -> Starten (Abbildung 9).
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Nun kann das Ergebnis der Mafinahme , Wiederver-
nassung” im Ergebnisdialog , Stoffeintrage” abgele-
sen werden (Abbildung 19). Die Berechnungsergeb-
nisse wurden, unter Beriicksichtigung der definier-
ten Mafsnahme, durch die Simulation aktualisiert.
Im Vergleich zu der Ausgangssituation ohne Mafs-
nahme reduziert sich die gesamt eingetragene Stick-
stoffmenge fiir das deutsche Gesamteinzugsgebiet
von ca. 222.600 t/a auf ca. 199.000 t/a. Weiterhin re-
duziert sich der Anteil des Dranageflacheneintrags
von urspriinglich ca. 23% auf ca. 12%.

Die raumliche Verteilung der Stickstoffeintragsmen-
gen kann wieder in der Kartendarstellung auf Teil-
einzugsgebietsebene betrachtet werden (Abbildung
20).

@ Stoffeintrige

Analysebereich
* Gesamteinzugsgebiet
" Teilgebiet

Teilsinzugsgebiete

FO/&

Substanz

Drénage Flachen [t/a]: 2428140
Grundwasser [t/a]: 98539,33
Erosion [tfa]: 4719.59

B 326 % Atmosphérischen Direkteirtrag)
W 1,08 % Oberflichensbfiuss

B 237 % Erosion

W 43,53 % Grundwasser
[ 533 % Urbane Flachen
I 23,23 % Punkiquellen

[ 12,2 % Drénage Flachen

|| |sesamtstickstoff ~|
Eintragsmengen
Atmosphatischen Dirskteintraq [t/a]:| 6476.54  Oberflachenabfiuss [tia]:|  2150.64

Punktquellen [t/a]: 4621939
Urbans Flachen [tfal: 16551.66
Gesamtsumme [tfa]: 198963.59

Werteilung

Abbildung 19. Darstellung der Auswirkungen der Mainahme ,Wiederverndassung”

fiir das Entwicklungsziel , Verringerung von Stickstoffeintragen”.

stoff[Ua]  (1:1.84177e+006 )

Abbildung 20. Kartendarstellung des Ergebnisses der Mainahme , Wiedervernis-

sung” fiir das Entwicklungsziel ,, Verringerung von Stickstoffeintrigen”.
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Zur spateren Analyse und einem Vergleich mit der Mafsnahme
,Aufforstung” speichern Sie auch diese dargestellte Ergebniskar-
te. Hierzu dient der Mentipunkt , Save Grid” im Menii ,,Grid O-
perations” (Abbildung 12). Wahlen Sie eine geeignete Bezeich-
nung und einen geeigneten Speicherort aus, damit Sie das Be-
rechnungsergebnis zu einem spateren Zeitpunkt wieder finden
(Abbildung 21).

Mit dem bisherigen Vorgehen sind die Auswirkungen der Beispielmafsnahmen zwar vollstandig berechnet worden, ein Blick auf
die Ergebniskarte ldsst die raumliche Verteilung der Mafinahmeneffekte jedoch nicht eindeutig erkennen. Daher werden nun wei-

Speichern unter EIE|

Speichern in: |_} beizpielaufgabe2 j &= I‘fF '

Y

i)

Zuletzt
venwendete D,

Desktop

-,

Eigene D ateien

Arbeitsplatz
‘:__‘] D ateiname: |n_wiedewemaessung_2ﬂ j Speichem |
2
Metzwerkumgeb D ateityp: |Idlisi Files j Abbrechen

ung

Abbildung 21. Speichern der Ergebniswerte der Wiedervernis-

sungsmafsnahme

tere Analysewerkzeuge herangezogen, um diese Effekte herausarbeiten zu konnen.

Hinweis: Die nun folgende Aufarbeitung der Ergebnisse dient nur der Herausarbeitung der regionalen Effekte der beiden MafSnahmen und

stellt lediglich eine kartenorientierte Weiterverarbeitung dar.
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Untersuchung der Mafinahmen ,, Aufforstung” und ,, Wiederverndissung” mit Hilfe des Map Comparison Kit

Die Veranderungen lassen sich durch einen einfachen optischen
Vergleich der Karten nicht eindeutig feststellen. Um diese Unter-
schiede herauszuarbeiten wird das Map Comparison Kit ver-
wendet.

Hinweis: Momentan liegt das Map Comparison Kit als externes Werk-
zeug vor. Eine Integration des Werkzeuges in das DSS ist geplant.

Starten Sie das Map Comparison Kit {iber Start -> Programme ->
Map Comparison Kit -> Map Comparison Kit (Abbildung 22).

Nach dem Starten des Werkzeuges werden Sie aufgefordert ein
Log File zu offnen (Open Dialog, Abbildung 23). Verlassen Sie
diesen Dialog durch , Abbrechen”, da wir dieses Log File zu-
nachst erstellen miissen.

fh Map Compatison kit

ﬁ Map Comparison kit

RIKS Weh Page
'@ ser Manual

Abbildung 22. Das Starten des Map Comparison Kits geschieht iiber
das Start Menii.

Open Elgl
Suchen in: ‘ |3 Map Comparison Kit j o £ '
|k
L\ﬁ ()Palettes
Zuletzt
vensendete O
?_E
Desktop
Eigene Dateien
<9
Arbeitzplatz
)
Metewerkumaeb  Dateiname: ‘ ﬂ Offnen
ung
Diateityp: [Log Files log) | Abbrechen

Abbildung 23. Beenden Sie den ersten Open Dialog iiber , Abbre-
chen”.
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Nachdem das Map Comparison Kit geladen ist, miissen die
zu vergleichenden Daten eingetragen werden. Dies ge-
schieht iiber den Mentipunkt ,File -> New”. Es erscheint
der Edit Log File Dialog (Abbildung 24).

Das Log File dient dem Verwalten von (Raster-) Datensat-
zen, die im Map Comparison Kit mit einander verglichen
werden sollen. Datensatze, die miteinander verglichen
werden sollen, mussen sich innerhalb eines Themas befin-
den. Momentan befindet sich lediglich ein leeres Thema
innerhalb des Log Files. Klicken Sie es mit der Maus an und
geben Sie dem Thema {iiber den ,Rename” Knopf einen
aussagekraftigen Namen. Bei der Namensvergabe miissen
Sie auf deutsche Umlaute und andere Sonderzeichen ver-
zichten.

Benutzen Sie anschliefsend den ,Import“-Button um nach-
einander die zu analysierenden Datensédtze zu laden, die Sie
im Verlauf der Ubung bisher erzeugt haben (Abbildung 25).

Hinweis: Wiihlen Sie als Dateityp , Idrisi Image Files (*rst, *img)
aus, da die Dateien in diesem Format vom Elbe-DSS gespeichert
werden.

Abbildung 24.

Edit Log File X

(X)

Mew theme

Region map

Add Theme
Import...
Remaove

Rename

LR

Legends. ..

I

O

J Cancel

Im Map Comparison Kit zu analysierende Daten miissen zu-
ndchst im Log File eingetragen werden.

Import...

Suchen in: | () beizpiglaufgabe2

n_aufforstung_10_10.img
n_referenz.img
n_wisdervernasssung_20.img

~l e @k @

Drateiname:

Dateityp: Idrisi Image Files [*rst; “.ima)

Abbrechen

Abbildung 25. Das Importieren der Daten in ein Thema ist notwendig, be-

vor die Analyseschritte durchgefiihrt werden kénnen.
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Tragen sie als ,Region map” (Abbildung 24) die
Datei

C:\programme elbedss\ data\ maps\ teileinzugs
gebiete\ moneris_tezg500.img ein. Diese Datei
dient lediglich der besseren Darstellung. Durch
sie sind die einzelnen Teileinzugsgebiete besser
voneinander abzugrenzen.

Anschliefiend sollte ihr Log File dhnlich wie in
Abbildung 26 aussehen.

Anschlieffend werden Sie zum Speichern des neu
erzeugten Log Files aufgefordert (Abbildung 27).
Ein neu erzeugtes Log File muss gespeichert
werden, bevor weitere Analyseschritte durchge-
fithrt werden konnen. Legen Sie das Log File am
besten im selben Verzeichnis wie die zu analysie-
renden Datensatze ab.

Edit Log File X

=I- exercisefufforstungWiedervernaessung
... \beispielaufgabezin_referenz.img
... \beispiglaufgabe?|n_aufforstung_10_10.img
... \beispielaufgabeZ|n_wiedervernaessung_20.img

Reqion map

|C:\Prngramme\E\heD5S1data1maps1te|\elnzugsgeh\ete\mnnerls_ D

]

Cancel

LR

EY

Add Theme
Impott, ..
Remave

Rename

Legends...

K

Abbildung 26 Das Log File nach Laden der drei Dateien und setzen der ,,Region map”.

Save As E‘g‘

Speichem in: |_) beispielaufgabe? j oF E2-

1

w

Zuletzt
venwendete D

Desktop

Eigene D'ateien

=1
<
Arbeitsplatz
) |
Metawerkumgeb  Dateiname: ‘exerciseAulforslungWiedervemaessung ﬂ Speichem
ung
Dateityp: ‘Lug Files [ log] j Abbrechen

£

Abbildung 27 Ein neu erzeugtes Log File muss gespeichert werden, bevor die Analy-
seschritte durchgefiihrt werden konnen.
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Die weiteren Arbeitsschritte wer-
den Sie mithilfe der Toolbar des
Map Comparison Kits durchfiihren.
Die wichigsten Elemente der Tool-
bar sind in Abbildung 28 darge-
stellt.

Hinweis: Sollten Sie das Log File im
Laufe der Ubung nochmals verindern
wollen, verwenden Sie den Meniipunkt
,Edit > Log file” oder den entspre-
chenden Button der Toolbar.

Stellen Sie zunachst sicher, dass das
von Thnen eben erstellte Thema in
der ersten Drop-Down Liste einge-
stellt ist. Wahlen Sie in der nachsten
Drop-Down Liste (erster Datensatz)
den Datensatz, der den Referenzzu-
stand reprasentiert. In der dritten
Drop-Down Liste (zweiter Daten-
satz) wahlen Sie zunachst den Da-
tensatz, der das Berechnungsergeb-
nis fur die Mafinahme , Auffors-
tung” enthalt (Abbildung 29).

Aktuell im Einsatz befindliches
Thema des aktuellen Log files.

Toolbar B
|@ [E ElbeDSSUebunal j T | .\ekelcwse_emslonsschutzmassnahme\ref_p.\j z \E\_:_._ﬁ_g_ﬁglcwse eroslDnsschutz_r_nassmahme\eloslorfj lj} ] |

Editieren des

) Erster und zweiter Datensatz, die Einstellen und
aktuellen Log files miteinander verglichen werden Anzeigen der
sollen. Die Anzeige geschieht {iber Analysefunktionen
die Knopfe 1 und 2

Abbildung 28. Die wichtigsten Elemente der Toolbar des Map Comparison Kits.

|exercisa&uffor3tung‘u\;’iecﬂ 1 |...\I:ueispielaufgabe2\n_referenz.img ﬂ 2 |...\I:ueispieIaufgabe2‘\n_auffnrstung_1D_1E|.imgj

Abbildung 29. Die drei Drop-Down-Listen der Toolbar dienen zum Einstellen des Themas und der

1

beiden Datensitze, die miteinander verglichen werden sollen. Die Knopfe und 2 dienen der

Anzeige der Datensitze.
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Nachdem Sie diese Einstellungen vorgenommen

haben, betitigen Sie die Knopfe 1 und % um

die Datensatze darzustellen (falls dies noch nicht
geschehen ist).

Als Ergebnis erhalten Sie eine Darstellung der
Stickstoffemissionen fiir den Referenzzustand
und fiir die Aufforstungsmafsnahme, wie sie im
Elbe-DSS berechnet wurden. Abbildung 30 zeigt
dies beispielhaft fiir den Referenzzustand. Bei der
Darstellung wird standardmafiig eine andere als
die dargestellte Legende verwendet, dies bleibt
tir die Auswertung jedoch ohne Relevanz.

Zum Vergleich der MafSsnahme , Aufforstung”
mit dem Referenzzustand wéhlen Sie iiber den
Mentipunkt , Options -> Comparison Method”
aus. Im daraufhin erscheinenden Eingabedialog
,Comparisons and other operations” (Abbildung
31) wahlen Sie den Unterpunkt ,second — first”
aus, um die absoluten Veranderungen der Auf-
forstungsmafsnahme zum Referenzzustand in t N
/ a zu betrachten.

CoopooDogEE

Abbildung 30. Die Anzeigefenster des Map Comparison Kits. Dargestellt sind die
Stickstoff-Emisssionen im Referenzzustand in Tonnen pro Jahr und Einzugsgebiet.

Comparisons and other operations g]
Compare categories
Ok
" Per category _
 Collby el Eancs)

" Fuzzy Interence System algorithm

" Fuzzy Set algorithm

Compare numernical values

" second - first

" abs| second - first |

" [=second - first ] / max( abs| second - first J]

™ abs| second - first ] / maw( abs( second - first ])
" second / first

" abs{ second / fitst )

NODATA

" {NDDATAx) =NODATA {5 FNDDATAx) = (0%

Other operations

" first + second

™ first + o
 first= 1

Abbildung 31. Im ,,Comparisions and other operations”-Dialog kann die
Vergleichsmethode ausgewdhlt werden. Wahlen Sie zunichst ,second — first” aus.
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Stofien Sie anschliefsend mit , Options -> Result Map” die Berechnung des
Ergebnisses an. Als Ergebnis erhalten Sie die Darstellung der Differenzen
zwischen beiden Zustanden (Abbildung 34). In unserem Fall handelt es
sich um die Abweichungen in Tonnen Stickstoff pro Jahr und Einzugsge-
biet.

Um die Legendeneinteilung analog der Abbildung 34 anzupassen doppel-
klicken Sie auf die momentan sichtbare Legendeneinteilung. Darauthin
erscheint der Legenden-Editor (Abbildung 32).

Zur automatischen Berechnung der Klassengrenzen Klicken Sie den Knopf
,Hints...” woraufhin der Eingabedialog ,Scale presets”
(Abbildung 33).

erscheint

Behalten Sie als Berechnungsmethode , Arithmetic sequence” bei, aktivie-
ren Sie die Berechnung durch Klicken des Knopfes ,Calculate” und tiber-
nehmen Sie die Berechneten Klassengrenzen durch Verlassen des Einga-
bedialoges tiber den Knopf , Accept”. Daraufhin werden die berechneten
Klassengrenzen im Legenden-Editor tibernommen. Zur Darstellung so-
wohl der Unter- als auch der Obergrenze der Klasseneinteilung wahlen Sie
im Legenden-Editor im Auswahlbereich , Labels” den Eintrag ,Lo...Hi".
Zur Ubernahme aller getroffenen Einstellungen und zum Zuriickkehren in
die Kartendarstellung (Abbildung 34) verlassen Sie den Legenden-Editor
tiber den Knopf ,Save”.

Palette settings

| R
[ EE
M os0
Mo
oz
Hom
O
[0 040
= 050
[ o0
| EI)

Legend type

" Categoric

Display interval

Scale

* Linear scale
r

" Custom scale
Top legend is

& Display Max

" Display Min

Palette [ |
Palelte edtor  Start

* Mumeric

Min |11 Max |11

Lepend editor - [exerciseAufforstungWiedervernaessungminusdiff.txt] E‘

Top of legend is
¥ Palette color 1 Palette color N

M Colors

N Classes |11

Mumeric legend settings

Humber format
Decimals |2
Lahets

Lo

 Hi

& (Lo+Hi2

¢ Custom

" Lo Hi

Cancel

Hirts.

Apply

Abbildung 32.Legenden-Editor zur Bestimmung der darge-
stellten Klasseneinteilung.

Scale presets
Method
(" Arithrnetic sequence
(" Geometrical sequence
" Geometrical sequence 2
™ Harmonic sequence
" Guantiles
(" Standardised Discretion

(" Method of Bertin

sum of squared deviations between classes:

—

Sum of squared deviations within classes:

—

X
Bccepl
==

Cancel

Abbildung 33. Eingabedialog zur automatischen Berech-
nung der Klassengrenzen.
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In der nun angepassten Kartendarstellung lasst
es sich schnell erkennen, dass alle Veranderun-
gen negativ sind, die Stickstoffemissionen somit
in allen Einzugsgebieten zum Referenzzustand
abgenommen haben. Weiterhin lassen sich die
Gebiete der absolut grofiten Reduktion ausma-
chen. So findet sich die maximale Abnahme
durch die Mafinahme , Aufforstung” mit ca. 350
t N/a im nordlichsten Teileinzugsgebiet wieder.

Zum Vergleich der Aufforstungs- mit der Wie-
derverndssungsmafinahme wahlen Sie nun in
der Toolbar als zweites Thema anstatt dem Da-
tensatz mit den Ergebnissen der Aufforstungs-
mafsnahme den Datensatz mit den Ergebnissen
der Wiedervernassungsmafinahme (Abbildung
35).

2 Map Comparison Kit - excerciseAufforstungWiedervernaessung - [Result map s second - first]
I3 Fle Ed Mew Options Mindow Help BEE

ngwier v| A [ \beispilautgabe2in_referenzimg v

W -357.08 ... -

Abbildung 34. Darstellung der Verinderung der Stickstoffemission in Tonnen pro Jahr
und Einzugsgebiet durch die gewihlte Aufforstungsmafinahme

|e:-:eru:ise.-’-‘-.uffnrstungWiec ﬂ 1 |...\I:uei&pielaufgabeE\n_referenz.img ﬂ 2 \beizpielaufgabe2in_wiederverna

Abbildung 35. Auswahl des 2. Themas in der Drop-Down Listen des Toolbars. Statt dem
Aufforstungs- soll nun der Wiedervernissungsdatensatz ausgewdahlt werden.
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Darauthin wird die Ergebniskarte mit der Differenzdarstellung zum Re-
ferenzzustand um die Wiedervernassungsmafsinahme automatisch aktua-
lisiert (Abbildung 36). D.h. nun wird die absoluten Veranderungen der
Wiederverndssungsmafsnahme zum Referenzzustand in t N / a darge-
stellt.

In der Kartendarstellung ldsst es sich nun erkennen, dass die Stickstoff-
emissionen durch die Mafinahme , Wiederverndssung” deutlich starker
zuriickgegangen sind im Vergleich zu der Mafinahme ,, Aufforstung”.
Dies wird nicht zuletzt dadurch deutlich, dass nun eine Vielzahl von
Teileinzugsgebieten in der niedrigsten Klasse liegen. Will man den ma-
ximalen absoluten Riickgang durch die WiederaufforstungsmafSnahme
gegeniiber dem Referenzzustand betrachten, so muss die Legendenein-
teilung, wie oben beschreiben, erneut berechnet werden. Da bei dieser
Ubung die qualitative Betrachtung im Vordergrund steht, wurde darauf
verzichtet.

Der néchste Schritt ist es, die relativen Anderungen zu vergleichen. Ab-
solute Werte konnen hinsichtlich der Wirksamkeit der MafSsnahme tau-
schen; eine Reduktion um 10 Tonnen pro Jahr kann bei einer Gesamt-
emissionsmenge von 20 t/a sehr beachtlich sein, wahrend sie bei einem
Ausgangswert von 1000 t/a eher bescheiden ausfallt.

Relative Anderungen lassen sich mit der Option ,second / first” darstel-
len (Abbildung 37). Der zugehorige Dialog ist tiber , Options -> Compari-
son method” erreichbar. Da in unserem Beispiel alle Anderungen in die-
selbe Richtung weisen (hier negativ sind), konnen wir auch die Option
,abs ( second / first ) verwenden, die die Absolutwerte der relativen
Anderungen ausgibt.

W 5951000

52

[[]-243.46 ... 205.

27592 .. 240.06
30290 .. 275.92
[-324.62 ... -302.98
[ -340.85 ... -324.62
B -351.67 ... -340.85
Bl -357.08 ... 351.67

244 o 435 £ 642845

Abbildung 36. Verinderung der Stickstoffemission in Ton-
nen pro Jahr und Einzugsgebiet durch die gewihlte Wieder-
verndssungsmafinahme.

Comparisons and other operations X

Compare categories

" Per category

© Cell by cell Car=d
" Fuzzy Inference System algorithm

€ Fuzzy Set algaiithm

Compare numerical values
" second - first

e abs| second - it )
" abe] second - first ) / max| abs{ second - fst )}
" second /fist
& bl second / frst ]
NODATA
" HNODATAX)=NODATA & HNODATA) =A0x)

Other operations

" first + second

 first + o
© fist* 1

Abbildung 37. Wihlen Sie nun im , Comparisions and other
operations“-Dialog die Methode ,abs( second / first)” aus.
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Durch Verlassen des Eingabedialogs durch Klicken auf den , OK*”-
Knopf wird die Ergebniskarte um die neu gewdhlte Vergleichsme-
thode aktualisiert (Abbildung 39).

Um die Legendeneinteilung analog der Abbildung 39 anzupassen
doppelklicken Sie auf die momentan sichtbare Legendeneinteilung.
Daraufhin erscheint der Legenden-Editor (Abbildung 38).

Wahlen Sie dazu in der Drop-Down Liste ,Palette” im Auswahlbe-
reich ,Palette settings” den Eintrag ,b127w127r.smp” aus und setzen
Sie den Min-Wert des ,Display interval” auf 0.5 sowie den Max-Wert
auf 1. Zur Darstellung sowohl der Unter- als auch der Obergrenze der
Klasseneinteilung wéhlen Sie im Legenden-Editor im Auswahlbereich
,Labels” den Eintrag ,Lo...Hi”. Stellen Sie die Anzahl der Klassen in
,NClasses” auf 5 ein.

Zum Ubernehmen aller getroffenen Einstellungen und zum Zuriick-
kehren in die Kartendarstellung (Abbildung 39) verlassen Sie den Le-
genden-Editor tiber den Knopf ,,Save”.

In der angepassten Kartendarstellung wird nun die relative Verande-
rung der Wiederverndssungsmafsnahme gegeniiber dem Referenzzu-
stand abgebildet. Es lasst sich erkennen, dass in den nordlichen Teilen
des Elbeeinzugsgebiet tendenziell die grofieren relativen Abweichun-
gen vom Referenzzustand zu beobachten sind. Dies lasst sich damit
erkldren, dass in den Flachlandbereichen der Elbe ein groflerer Dra-
nagefldchenanteil an der gesamten landwirtschaftlichen Nutzflache
existiert als in den Mittelgebirgsregionen.

Legend editor - [nmassnahmenabsreldifflocal. txt]

ar

Wos.
[EER

Mos.
Hos.

Palette settings

! ave
0 Top of lagend e - :
e Pelette [b127wi27ismp  w| | ¢ Paleflecclor] & Paletie colorl Cancel
08
Ly Palette editcr Start... N Colors
08

Legend twpe

" Categoric % Numeric N Classes |3

Mumeric legend settings
Display interval MNumber format

Min |05 Max |1 Decimals |1 Hints.

Scale Labels
f* Linear scale e

o
CoHi
" Custom scale
Lo+ Hi)s2
Top legend is
5 Display Max " Custom

" Display Min ® Lo _Hi

Apply

Abbildung 38.Legenden-Editor zur Anpassung der Darstellung

der relativen Veranderung.

Abbildung 39. Darstellung der relativen Veranderung der Stick-
stoffemission pro Einzugsgebiet durch die gewdhlte Wiederver-
ndssungsmafinahme gegeniiber dem Referenzzustand.
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Um abschliefsend die relative Verdnderung der Auf-
forstungsmafinahme gegeniiber dem Referenzzu-
stand betrachten zu konnen, wahlen Sie erneut in
der Toolbar als zweites Thema den Datensatz mit
den Ergebnissen der Aufforstungsmafsnahme aus
(Abbildung 35). Daraufhin wird die Ergebniskarte
um Werte der relativen Veranderung der Auffors-
tungsmafinahme automatisch aktualisiert
(Abbildung 40).

Es wird deutlich, dass die gewahlt Aufforstungs-
mafinahme einen geringeren Effekt als die Wieder-
verndssungsmafsnahme zeigt. Auch eine Kategorisie-
rung der Mafinahme , Aufforstung” hinsichtlich ei-
ner verstarkten Wirksamkeit im Flachland- oder Mit-
telgebirgsbereich kann im Gegensatz zur Wieder-
vernassungsmafinahme nicht vorgenommen wer-
den.

Das Map Comparison Kit kann nun beendet werden
(File -> Exit). Falls Sie die Anderungen im Elbe DSS
speichern mochten, tun Sie dies bitte tiber ,, Datei ->
Speichern unter” um die Original Datei ElbeDSS.eif
in ihrem urspriinglichen Zustand zu bewahren. An-
schliefSend konnen Sie das Elbe-DSS beenden (Datei
->Beenden).

Cos...
[Jos...
o7 ..
[Jos...
Wos...

Abbildung 40. Darstellung der relativen Veranderung der Stickstoffemission pro
Einzugsgebiet durch die gewihlte Aufforstungsmafinahme gegeniiber dem Refe-

renzzustand.
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